
 

 

 

 

 

ETC II Network Communicator 

 
 
 
 
 
 
 
 
 
 

 

Installation and Operation Manual 

 
 
 
 
 
 
 
 
 

BG0594 Rev. A1 



 

 

2 ETC II Network Communicator 
 

LIMITED WARRANTY 

The manufacturer offers the customer a 24-month functional warranty on the 
instrument for faulty workmanship or parts from date of dispatch from the 
distributor. In all cases, this warranty is valid for 36 months from the date of 
production. This warranty is on a return to factory basis. 

The manufacturer does not accept liability for any damage caused by 
instrument malfunction. The manufacturer accepts no responsibility for the 
suitability of the instrument to the application for which it was purchased. 

Failure to install, set up or operate the instrument according to the instructions 
herein will void the warranty. 

Only a duly authorized representative of the manufacturer may open your 
instrument. The unit should only be opened in a fully anti-static environment. 
Failure to do so may damage the electronic components and will void the 
warranty. 

The greatest care has been taken to manufacture and calibrate your 
instrument. However, these instructions do not cover all possible 
contingencies that may arise during installation, operation or maintenance, 
and all details and variations of this equipment are not covered by these 
instructions.   

For additional information regarding installation, operation or maintenance of 
this instrument, contact the manufacturer or your local representative or 
distributor. 

WARNING 

Read the instructions in this manual before performing installation, and take 
note of the following precautions: 

 Ensure that all incoming AC power and other power sources are turned 
OFF before performing any work on the instrument. Failure to do so may 
result in serious or even fatal injury and/or equipment damage.  

 Before connecting the instrument to the power source, check the labels 
on the back of the instrument to ensure that your instrument is equipped 
with the appropriate power supply voltage, input voltages and currents. 

 Under no circumstances should the instrument be connected to a 
power source if it is damaged. 

 To prevent potential fire or shock hazard, do not expose the 
instrument to rain or moisture. 

 The secondary of an external current transformer must never be allowed 
to be open circuit when the primary is energized. An open circuit can 
cause high voltages, possibly resulting in equipment damage, fire and 
even serious or fatal injury. Ensure that the current transformer wiring is 
secured using an external strain relief to reduce mechanical strain on the 
screw terminals, if necessary. 

 Only qualified personnel familiar with the instrument and its associated 
electrical equipment may perform setup procedures. 

 Do not open the instrument under any circumstances when it is 
connected to a power source. 

 Do not use the instrument for primary protection functions where failure 
of the device can cause fire, injury or death. The instrument can only be 
used for secondary protection if needed.  

Read this manual thoroughly before connecting the device to the current 
carrying circuits. During operation of the device, hazardous voltages are 
present on input terminals. Failure to observe precautions can result in serious 
or even fatal injury or damage to equipment. 

All trademarks are property of their respective owners.  

Copyright SATEC Ltd.  2008  
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Chapter 1   General Information 
The ETC II Network Communicator is a multi-port Internet-to-serial that 
connects multiple serial RS-485/422 or wireless ZigBee devices to the Internet 
via a local Ethernet network or via public telephone lines. It can also be used 
as an Internet-to-Internet router for connecting master stations to remote slave 
devices that are directly connected to the Internet. The ETC II provides 
transparent master-slave connections using TCP/IP versions of the popular 
industrial fieldbus protocols such as Modbus RTU, DNP3, and SATEC ASCII.  

The embedded Data server allows the ETC II to automatically acquire data 
from slave devices and to store it in the memory exchanges or in the data log 
files in non-volatile memory, so a user application can read blocks of acquired 
data directly from the ETC II exchanges without waiting for a response from 
slow serial and wireless devices. The application can also write data to slave 
devices via the ETC II exchanges instead of waiting until a remote device is 
accessible. The Data server may be programmed to monitor the slave device’s 
status registers for specific events and to record them to a log file, and send 
alerts to a remote server. 

Features: 

 Ethernet 10/100Base-T port communicating to the IP network 

 Service USB Device port to communicate with PAS 

 Two RS-422/RS-485 master ports for connecting to serial networks 

 Service RS-232 port that can be used as a slave port for serial master 
applications 

 Optional CELLULAR modem port communicating to the IP network 

 Connections using popular field-bus protocols such as Modbus TCP 

 Terminal connection 

 Telnet service 

 Embedded Data server: up to 250 real-time data exchanges, up to 250 
data write exchanges, and up to 250 16-bit status event exchanges 

 Up to 250 data log files 

 Event log for recording status change events and device diagnostics 

 Table top, DIN Rail or wall-mounting options 

 4 Mbyte non-volatile memory with battery backup for storing data and 
event files 

 Real Time Clock 

 120/240V AC/DC operation  

 

 

 



Chapter 2  Installation Mechanical Installation 
 

 

6 ETC II Network Communicator 
 

Chapter 2   Installation 

Mechanical Installation 
The ETC II can be located on a table top, or be mounted on a 35-mm DIN rail 
or on a panel. See Figures 2-2 through 2-4 for mounting instructions. Figure 
2-1 shows the device dimensions. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2-1 ETC II Dimensions 

 

Figure 2-2 Table Top Placement 
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Figure 2-3 Din Rail Mounting 

 

Figure 2-4 Panel Mounting 
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Electrical Installation 

Power Source Connection  

Before connecting your device to the power source, check the label on the 
back of the device to ensure that it is equipped with the appropriate power 
supply. 

AC power supply: Connect the line wire to terminal L/+ and the neutral wire to 
terminal N/-.  

DC power supply: Connect the positive wire to terminal L/+ and the negative 
wire to terminal N/-. 

 

Figure 2-5 Power Source Connection 

Chassis Ground Connection 

Connect the chassis ground of the device to the switchgear earth ground 
using a dedicated wire greater than 2 mm2/14 AWG. 

Serial Port Connection 

The COM3 RS-232 service port is normally used for servicing and setting up 
the ETC II. It can also be used as a slave port for serial-to-serial 
communications via the ETC II gateway.  

The COM4 and optional COM5 gateway ports are used for connecting the 
ETC II to the RS-422/RS-485 slave networks with up to 32 devices on each 
network. For device routing rules, see Routing Messages over Slave 
Networks in Chapter 3.  

The COM4 port can also be used as a slave port for a connection of a master 
application to the ETC II via an RS-422/RS-485 serial network. 

For proper serial communications, ensure that all port parameters, such as 
the communication protocol, baud rate, data format and parity, are correctly 
set in both the ETC II and in the connected serial devices. See Serial Network 
Connections in Chapter 3 and Configuring Serial Ports in Chapter 5 for the 
ETC II setup instructions. Refer to Figures 2-6 through 2-11 for the connection 
diagrams. 
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Figure 2-6 Serial Network Connection 

COM3 RS-232 Connection 

 

Figure 2-7 Simple RS-232 3-Wire Connection, 9-pin Female Connector   

 

 

Figure 2-8 Simple RS-232 3-Wire Connection, 25-pin Connector 

 

  

  

  

ETC II 

ETC II 

ETC II 



Chapter 2  Installation Electrical Installation 
 

 

10 ETC II Network Communicator 
 

COM4/COM5 RS-422/RS-485 Connection  

 

Figure 2-9 Multidrop RS-422 Connection 

 

Figure 2-10 Multidrop RS-485 Connection 

 

Figure 2-11 Multidrop RS-485 Connection 

  

  

  

ETC II 

ETC II 

ETC II 
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Internet Connections  

The ETC II is connected to the Internet either via a local Ethernet network, or 
via public telephone lines using a Dial-Up PPP connection. 

 Connecting a device with the factory-set IP address to the Ethernet network can 
disrupt communications if the IP address exists on the network. Change the IP address 
in your ETC II as instructed in Section 4 before connecting a device to the network. 

Ethernet Connection 

Plug the end of the Ethernet cable that came with your device into the wall 
Ethernet jack or into the Ethernet hub jack, and the other end into the RJ45 
jack at the front of the ETC II marked ETHERNET.  

 

Figure 2-12 Network Connections 

See Internet Connections in Chapter 3 and configuring the Network in Chapter 
5 for instructions on how to program your device for networking via Ethernet. 

  
 

ETC II 
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Chapter 3   Operating the ETC II 

Controls and Indicators 

PROG-RUN Switch 

The ETC II has a PROG-RUN switch that puts the device into program mode 
for local servicing and programming. The switch must be in the RUN position 
for normal device operation. 

Put the PROG-RUN switch in the PROG position for setting up your device or 
upgrading device firmware via a Terminal program (see Using HyperTerminal 
in Chapter 4 for instructions). 

 LED Indicators 

 

 

 

 

 

 

 

Figure 3-1 Indicator LEDs 

The ETC II has two yellow device status LEDs and eight green network status 
LEDs that show the present device status and activity on communication 
ports. 

The flashing yellow CPU LED indicates the device status as follows: 

 The CPU LED flashing for one second with a one-second pause 
indicates that the device is in the operational state and is functioning 
normally. Depending on the position of the PROG-RUN switch, the 
COM3 service port is available for communications via a Terminal 
program or for master communications. 

 The CPU LED flashing briefly 2 times with a one-second pause 
indicates that the device is in service mode and is not operational. 

 The CPU LED flashing briefly 3 times with a one-second pause 
indicates that a critical error has occurred and the device is not 
operational. Contact your local distributor for servicing. 

The yellow BATTERY LOW LED lights up when the backup battery is near the 
end of its operational life and should be replaced. 

The network status LEDs indicate activity on communication ports as follow: 

 COM2 Cellular port optional plug-in module (future): the RX and TX 
LEDs flash when the device communicate with the Cellular Modem 
port. 

 COM3, COM4 and COM5 serial ports: the RX and TX LEDs flash 
when the device receives or transmits data via a port. 

Modes of Operation 

Operational Mode 

In the operational mode, the device services the Internet to serial gateway 
connections from client applications, and the COM3 port operates in slave 
mode allowing serial-to-serial network connections. 
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To put the ETC II into operational mode, set the PROG-RUN switch in the 
RUN position.  

 Program Mode 

In program mode, the COM3 port operates as a service port that allows the 
user to review or change settings in the device via a Terminal program (see 
Using HyperTerminal in Chapter 4 for more information). The device still 
services the Internet to serial gateway connections, but serial-to-serial master 
connections through the COM3 port are not available.  

To put the device into program mode, set the PROG-RUN switch in the PROG 
position. 

 Service Mode 

Service mode is used for local device servicing and upgrading firmware 
through a Terminal program. In service mode, the Internet-to-serial gateway 
is not operational. 

The device enters service mode either from program mode upon an explicit 
user command sent via a Terminal program, or when the device is powered 
with the PROG-RUN switch set in the PROG position.  See Upgrading Device 
Firmware in Chapter 6 for instructions. 

Using the ETC II 

Slave Network Connections 

Serial Network Connections 

The ETC II is connected to serial RS-422/485 slave networks via the COM4 
and COM5 gateway ports.  

The COM4 should be set to master mode to operate as a gateway port. The 
COM5 port is factory-set to master mode. See Configuring Serial Ports in 
Chapter 5 for information on programming serial ports. 

The communication protocol to be used for serial networking via the ETC II is 
defined by the Network TCP service port setting. See Configuring the Network 
in Chapter 5 for information on programming the ETC II TCP service port. 

Wireless RF Network Connections 

The COM5 port can be configured to support a wireless RF ZigBee slave 
network built on a Helicomm IP-Link platform.  

The IP-Link network is an expandable, low-rate wireless ZigBee platform, 
which allows various configurations, including mesh network topology to be 
programmed by the user to best match the installation conditions and 
applications networking needs. A network may contain up to 30 remote nodes 
with full mesh support and can operate at one of the seven frequencies from 
907MHz to 922MHz to avoid interference with other ZigBee networks.  

Slave ZigBee devices are provided with the embedded IP-Link 1000 modules. 
The ETC II is connected to a ZigBee network via an external IP-Link 2000 
modem that operates as a master node.  

A wireless network is used as a transparent media for delivering Modbus RTU 
messages. To identify devices on the network, each slave node is assigned a 
network ID that is identical to the device Modbus address. See Configuring 
Wireless RF Connections in Chapter 5 for information on configuring the IP-
Link module parameters in the ETC II. 

Internet Connections 

Starting with V21.5.4, the ETC II provides connections to slave devices that 
are linked to the Internet via the Modbus/TCP or DNP3/TCP protocol.  
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The device routing table is used for assigning the IP addresses to slave 
devices. See Routing Messages over Slave Networks below for more 
information on using the device routing table in the ETC II. 

To configure Internet connections for your devices: 

1. In the device routing table, specify the IP addresses for Internet devices 
connected to the ETC II. See Configuring Device Routing Table in 
Chapter 5 for more information. 

2. Enable the routing table in your ETC II via the ETC II Gateway Options 
Setup (see Configuring Gateway Options in Chapter 5). 

Master Network Connections 

Internet Connections 

 The ETC II provides a TCP server for master client connections on one of the 
standard TCP ports: 502 (Modbus/TCP), 20000 (DNP3/TCP) or 5002 (SATEC 
ASCII/TCP). The TCP server supports eight simultaneous client connections.  

NOTE: 

Starting with V21.5.4, the ETC II provides the permanent Modbus/TCP server 
on port 502. Selecting the TCP service port in the ETC II (see Configuring the 
Network in Chapter 5) launches an additional server either on the DNP3/TCP 
port 20000, or on the SATEC ASCII/TCP port 5002, allowing simultaneous 
connections on both ports.   

The TCP server can be accessed via a local Ethernet network or via a Dial-
up PPP Internet connection using an embedded 56K modem.  

The ETC II Dial-up port is programmable either for dial-in connections from a 
remote TCP client via Windows Dial-Up Networking services, or for dial-out 
connections to a remote TCP server via a local Internet Service Provider 
(ISP). 

Ethernet Connections 

To setup your Ethernet connections: 

1. Define the network IP parameters via the ETC II Network Setup. If you 
use the ETC II eXpertPower client connections via the Ethernet network, 
define a non-zero default gateway address, so the client connections will 
be directed to the Ethernet network (see Note in “Dial-Out Connections” 
below). 

2. Define the TCP service port number for your application protocol. 

See Configuring the Network in Chapter 5 for information on programming the 
TCP service port in your ETC II. 

Dial-In Connections 

To set up your dial-in connections, define the IP parameters for the modem 
interface: the IP address, subnet mask and default network gateway, and the 
number of rings before answering an incoming call.  

See Configuring Dial-Up Connections in Chapter 5 for more information on 
configuring your modem. See Dial-Up Networking in Chapter 4 for information 
on using Windows Dial-Up Networking for dial-in connections. 

Dial-Out Connections 

Dial-out connections are normally used with eXpertPowerTM applications. The 
ETC II eXpertPower client can initiate connections to the eXpertPowerTM 
server on a time basis. For information on configuring eXpertPower 
connections, see Configuring eXpertPower Client in Chapter 5.  

To configure your ETC II modem for dial-out connections: 



Chapter 3  Operating the ETC II Using the ETC II 
 

ETC II Network Communicator 15 

 

1. Set the default Ethernet gateway address to 0.0.0.0 to direct client 
connections to the modem network. See Configuring the Network in 
Chapter 5 for information on programming the Ethernet port in your ETC 
II. 

2. Define your service provider’s phone number, the login name and the 
password, and select the modem dialing options: the number of redial 
attempts, the time between attempts, and the connection timeout. Other 
IP connection parameters are automatically negotiated with the remote 
server. See Configuring Dial-Up Connections in Chapter 5 for information 
on configuring the Dial-Up modem. 

NOTE:  

If your ETC II has both the Ethernet and modem network interfaces, the 
eXpertPower client uses one of these for connections to the eXpertPowerTM 
server. The default Ethernet network gateway address defines which one of 
the networks is used. If the default gateway address is not defined (i.e., it is 
set to 0.0.0.0), the ETC II uses the dial-out modem connection via your local 
Internet provider. If you defined the default network gateway address, any call 
to the IP address, which is not included in the address space of the both 
networks, is redirected to the default Ethernet gateway.  

Serial Master Connections 

The ETC II can also be used as a serial-to-serial or a serial-to-wireless 
gateway. This provides connections to slave networks from serial applications 
using the COM3 RS-232 or the COM4 RS-422/485 slave port. 

To use the COM3 port as a slave port: 

1. Configure the COM3 port communication parameters for your master 
application. See Configuring Serial Ports in Chapter 5 for information on 
programming serial ports. 

2. Ensure that the PROG-RUN switch is in the RUN position. 

To use the COM4 port as a slave port: 

1. Configure the COM4 port communication parameters for your master 
application. See Configuring Serial Ports in Chapter 5 for information on 
programming serial ports. 

2. Ensure that the COM4 port direction in the port setup is set to “Slave”. 

Routing Messages over Slave Networks 

A device address is used to route master requests to a correct network where 
the target device is physically located. The device address range is 
programmable in the range of 1 through 247. It may be restricted by specific 
protocol limitations. 

One of the device addresses is reserved for accessing the ETC II 
configuration and data registers. The factory-set ETC II network address is 
99. It can be moved to another address via the ETC II Gateway Options setup 
if you wish to use the default ETC II address for addressing your slave 
devices. 

The ETC II has two options for routing messages over the slave networks, 
depending on whether the device routing table is defined in your ETC II or not.  

The first option uses implicit rules that identify the device location statically 
upon the device address. The following table shows how the messages are 
routed through the COM4 and COM5 serial ports depending on the port 
usage. When using non-standard communication protocols, all messages are 
routed to the COM4 port. 

Port COM5 
Unused 

COM4 Master + 
COM5 Serial 

COM4 Master + 
COM5 IP-Link 

COM4 Slave + 
COM5 

COM4 Master 1-247 1-32 216-247 - 

COM5 - 33-247 1-215 1-247 
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The second option uses the device routing table. It is available starting with 
V21.5.4. The routing table explicitly identifies the target network for every 
individual device connected to the ETC II. For serial and wireless devices, it 
specifies a serial port to which the device network is connected. For Ethernet 
devices, it allows you to specify the device’s IP address on the Ethernet 
network.  

To use the device routing table: 

1. Specify a routing path for every device connected to the ETC II gateway. 
Specify the IP address for every Internet device and the target serial port 
for every serial and wireless device connected to the ETC II. See 
Configuring Device Routing Table in Chapter 5 for information on 
programming the device routing table. 

2. Enable the routing table in your ETC II via the ETC II Gateway Options 
Setup (see Configuring Gateway Options in Chapter 5).  

Shared Device Access 

Shared device access allows several clients to simultaneously access the 
slave device’s registers either for reading or writing. It is enabled by the 
default, so different clients can poll registers in the same device without 
collisions that are normally resolved by the ETC II.  

However, accessing a file in the device at the time when another client is 
reading data from that or another file in the same device could destroy file 
buffers such that both clients may receive corrupted data.  

To avoid possible collisions, the ETC II offers you two options: 

1. First, you can entirely disable shared device access so that the ETC II 
rejects any additional requests addressed to a device that is being 
accessed by another client. In this event, the ETC II returns an exception 
response with the error code 10 “Gateway is busy” until the first client 
closes the session or points to a different device. See Configuring 
Gateway Options in Chapter 5 on how to enable or disable shared device 
accesses in your ETC II. 

2. The second option uses the device routing table for defining a device-
sharing policy. Shared device access should be enabled in the ETC II 
(see Configuring Gateway Options in Chapter 5), and device-sharing 
rules should be selected for each individual device. In this event, only 
protected registers, which are defined by a selected access rule, are 
blocked for shared accesses while others are always available for all 
clients. See Configuring Device Routing Table in Chapter 5 for 
information on programming the device-routing table. 

ETC II Network Applications 

Transparent Gateway 

The ETC II normally provides a means for transparent exchange of messages 
between master Internet and serial client applications, and slave serial or 
wireless devices.  

The ETC II can manage up to eight concurrent sessions between master 
stations and slave devices. Each connection is fully transparent for the 
master. The ETC II forwards client requests to target devices, and then returns 
responses to the master application, maintaining all timing regulations 
required by the protocol. The serial networks are accessed in a queued 
manner that prevents possible collisions.   

Data Server 

The ETC II has an embedded Data server that allows the user to save time 
required for polling multiple devices, especially via slow serial interfaces. It 
utilizes the ETC II non-volatile memory for automatic data acquisition. 

The Data server is accessible via the Modbus/TCP protocol from any remote 
application. The user application can read blocks of ready data directly from 
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the ETC II memory exchanges without the need to wait until slow devices 
respond to master requests.  

The Data server can also perform a delayed write of data so the application 
does not need to wait until the device is accessible, but rather can write data 
to the ETC II memory exchanges, with the ETC II then taking responsibility for 
delivering data to the target devices.  

The Data server can also periodically poll device status registers, record 
events to a log file and give alerts on specific events.   

The following table gives a summary of the available data exchanges. 

Exchange Type Number of 
Exchanges 

Exchange Block 
Size, registers 

Real-time data exchange 250 1-114 

Status event exchange 250 1 

Data write exchange 250 1-12 

NOTE: 

The real-time, status event and write data exchanges with the same 
exchange number are internally linked in the ETC II to the same device 
address. If you change the device address for one of the exchanges, the 
same address will be taken for other configured exchanges that have the 
same exchange number. 

See Configuring Data Server in Chapter 5 for information on configuring data 
exchanges. Refer to the ETC II Modbus Guide for information on accessing 
and retrieving data from the Data server exchanges. 

Real-Time Data Exchanges 

Real-time data exchanges are used for periodic retrieval of data from the 
connected devices. The ETC II provides up to 250 real-time data exchanges 
of 1 to 114 registers long. They are directly accessible from remote master 
applications. 

When the Data server is enabled, it acquires data from the connected devices 
either continuously, or on a periodic basis. If continuous polling is disabled, 
the devices are requested periodically at predefined poll intervals. If 
continuous polling is enabled, the ETC II retrieves data from the devices in 
turn without pauses.  

You can individually enable or disable polling data for a specific exchange. If 
the device has an onboard real-time clock, you can enable periodic RTC 
updates from the ETC II clock, which may be synchronized with the precise 
satellite GPS clock using an optional IRIG-B input. 

Acquired real-time data is normally stored in the ETC II exchanges. If the user 
wishes, acquired data can be periodically moved to historical circular files 
where data is kept for a long time until it is overwritten by newer data. 

Data is recorded to historical files at regular intervals. To enable logging, 
specify a non-zero logging interval in the Data Server Options setup (see 
Configuring Data Server in Chapter 5). The logging interval is always 
represented as a whole number of data polling intervals even if the polling 
itself is not synchronized with polling intervals, such as in the event of 
continuous polling. Since the ETC II attempts to synchronize polling devices 
with the beginning of an hour, it is recommended to program a logging interval 
in such a manner that it is a whole divisor of 60 minutes.  

Historical records can be read in an arbitrary manner, or in a sequential order. 
See the ETC II Modbus Guide for more information on retrieving log files from 
your device. 

Status Event Exchanges 

The Data server logs binary events asserted by the connected devices and 
gives notification to the eXpertPower server.  
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A binary event mask specifies critical event bits in the device status register. 
Whenever the Data server detects a change in the status bits selected by the 
event mask, it records an event record to the circular Event log file. If the 
eXpertPower service is enabled in the ETC II, this event initiates a connection 
to the eXpertPower server. 

Polling status events is performed via the status event exchanges. The Data 
server provides up to 250 event exchanges of 1 register long, with a separate 
event mask. 

The Data server provides the auto re-set option that may be used to clear a 
latched device status register after it has been read. In most devices, critical 
events are latched into a status register, so that the new events are not 
generated until the register is explicitly cleared by a master application.  

Since status registers may be implemented in the device either as coils, or as 
holding registers, you should specify a register type for each event exchange. 

Write Data Exchanges 

The Data server can provide remote writing data to serviced devices upon user 
request. Up to 250 write exchanges are supported with a size of 1 to 12 
registers.  

The following table shows the write exchange layout.  

Write Exchange Block 

Description Range 

Exchange 
number 

0-249 

Write flag 0 – Data has been 
written 
1 – Data is waiting 
to be written 

Data register 1  

...  

Data register 12  

 
To send data to a device via a write exchange, write data to the write 
exchange with the write flag being set to 1. The write flag is automatically 
cleared after the data has been successfully transferred to the device. Always 
check this flag before writing new data to the exchange to ensure it is empty, 
otherwise previously written data may be lost. 

Monitoring Digital Inputs 

The Data server provides continuous monitoring events asserted by the 
ET2002 digital inputs and gives notification to the eXpertPower server. 

Whenever the Data server detects a change in the status of the ETC II digital 
inputs, it records an event record to the Event log file. If the eXpertPower 
service is enabled in the ETC II, this event initiates a connection to the 
eXpertPower server. 

eXpertPowerTM Client 

The ETC II has an embedded eXpertPowerTM client that provides 
communications with the eXpertPowerTM server – the SATEC proprietary 
Internet services.  

Connections to the eXpertPowerTM server are normally handled on a periodic 
basis, but can also be initiated via the ETC II event exchanges and the ETC II 
digital inputs DI1-DI4 to give an alert for specific events. 

See Configuring eXpertPower Client in Chapter 5 for more information on 
configuring the eXpertPower client in your ETC II. 
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ETC II Clock 

GPS Clock Synchronization 

The ETC II has the IRIG-B input port for receiving the IRIG-B time code signal 
from an external GPS satellite clock. The ETC II IRIG-B port uses 
unmodulated pulse-width coded time code signal (unbalanced 5V level). 

To use the IRIG-B input: 

1. Connect the GPS master clock to the IRIG-B BNC connector on 
the front of the ETC II 

2. Define your time zone offset in the Local Settings setup. See 
Configuring Local Time Settings in Chapter 5 for information on 
configuring time options in your device. 

When the IRIG-B signal is present on the device input, the ETC II automatically 
synchronizes its clock with the GPS time each second, normally with accuracy 
better than 1 millisecond if the time is synchronized with the GPS satellite time. 
If the GPS clock loses the satellite signal, the clock continues to generate the 
IRIG-B time code referenced to the last available satellite time, but the time 
quality may deteriorate. Such signal losses can last from a few minutes to 
several hours. During such outages, the time code generated by the GPS 
receiver is typically accurate to within a few milliseconds over a 24-hour 
period. 

If the IRIG-B signal is not present on the device input, the ETC II automatically 
uses its internal RTC clock. 

Daylight Savings Time 

The ETC II clock can automatically switch the clock from standard time to 
daylight savings time (DTS) at preset time switch dates. The default 
factory-set time change points are set for the U.S.A.  

When the daylight savings time is enabled, the ETC II automatically adjusts 
the device clock at 02.00 AM when daylight savings time begins/ends.  

If the daylight savings time option is disabled, you must manually adjust the 
device clock for daylight savings time. The daylight savings time option is 
disabled in the ETC II by default. 

See Configuring Local Time Settings in Chapter 5 for information on 
configuring local time options in your device. 
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Chapter 4   Connecting to the ETC II 

Using HyperTerminal 
Windows HyperTerminal allows you to configure the network, communications 
and security settings in your ETC II, and to view certain diagnostic information 
such as device diagnostics and network statistics. HyperTerminal is also used 
for servicing the ETC II and upgrading the device firmware. 

Running HyperTerminal 

1. Connect your PC to the ETC II COM3 RS-232 port using the standard 
RS-232 DTE-DTE (null-modem) cable that came with your ETC II.  

2. Run HyperTerminal from the Windows Start -> Programs -> Accessories -
> Communications menu. 

Type a name for your new connection and click OK. 

 

In the “Connect Using” box, select the PC COM port to which your ETC II is 
connected and click OK. 

 

3. Select 19200 bps in the “Bits per second” box, select “Xon/Xoff” in the 
“Flow control box”, and then click OK. 
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4. From the File menu, select Save to save your settings for the ETC II 
session. When you next open a session and the New Connection dialog 
appears, click Cancel, select Open from the File menu, and then double-
click on your session file.  

Opening a Terminal Session 

Put the PROG-RUN key on the ETC II in the PROG position. 
The ETC II Terminal program is now launched and will print a 
list of the available commands as follows: 

ETC II Ethernet Converter Ver. 21.X.X 

SATEC/TCP Server, Modbus/TCP Server, DNP3.0/TCP 

Server. 

Copyright (C) 2002, SATEC Ltd. 

 

ETC Terminal commands 

--------------------------------------------- 

h                     Displays this text 

ver                   About ETC version 

password              Password setting  

ip                    TCP/IP settings 

port                  TCP service port number 

b                     Change the terminal baud 

rate 

COM[Port][Baud][Data] Serial port settings: 

                      Port = 3/4/5 

                      Baud = 1200/…/57600 

                      Data = 7E/8N/8E 

modem                 Modem connection parameters 

XP                    eXpertPower client 

parameters 

time [hh:mm:ss]       Time 

date [dd/mm/yy]       Date 

log                   Prints network log  

stat                  Prints network statistics 

stat ip            Prints current network 

IP addresses 

stat xp               Prints XP client status 

service               Service Menu 

datasrv               Data server configuration 
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run dump              Starts dumping the log to 

console  

run net               Starts the network 

run server            Starts the TCP server 

stop dump             Stops dumping the log to 

console 

stop net              Shuts the network down 

stop server           Shuts the TCP server down 

reset                 Resets the device 

quit                  Quit console 

 

 

You are prompted for the password to login, as in the following example:   

Login password: * 

 

> 

 

If your login was successful, you are not prompted for the password again until 
you close the terminal session. The default ETC II password is 0 unless you 
have changed it. A password is always required for a terminal session 
regardless of whether the communications security is enabled or disabled. 

After receiving the Terminal prompt “>”, you may enter your 
commands. 

Closing a Terminal Session 

To close your terminal session, put the PROGRAM-RUN key on the ETC II in 
the RUN position. 

Using Telnet 
Unlike HyperTerminal, Telnet allows you to access the device through a local 
network or from any location on the Internet where your device is visible. Just 
like Windows HyperTerminal, Windows Telnet allows you to configure the 
network, communications and security settings in your ETC II, and to view 
certain diagnostic information such as device diagnostics and network 
statistics.  

You can establish a telnet connection to the device from Windows 
HyperTerminal or from Windows Telnet Client. 

Running Telnet from HyperTerminal 

1. Run HyperTerminal from the Windows Start -> Programs -> Accessories 
-> Communications menu.  

2. Type a name for your new connection and click OK. 
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3. Select TCP/IP (Winsock) in the “Connect Using” box, type the ETC II IP 
address in the “Host address” box, and set the port number to 5023. Click 
OK. 

 

Running the Telnet Client 

1. From the Start menu, select Run, type telnet and click OK.  

 

The following text appears in a window: 

Microsoft (R) Windows 2000 (TM) Version 5.00 

(Build 2195) 

Welcome to Microsoft Telnet Client 

Telnet Client Build 5.00.99206.1 

Escape Character is 'CTRL+]' 

 

Microsoft Telnet> 

 

2. Type open followed by the ETC II IP address, followed by 5023 as the 

ETC II port number, for example: 

Microsoft Telnet>open 192.168.0.203 5023 

Opening a Telnet Session 

When a telnet connection is established, the ETC II Telnet server prints a list 
of the available commands as follows: 

ETC Telnet Commands. 

----------------------------------------------

------------ 

 h                - Displays this text 

 ver              - About ETC version 

 password         - Password setting 

 ip               - TCP/IP settings 

 port             - TCP service port number 
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 COM[Port] [Baud] [Data] - Serial port 

settings: 

                     Port = 3/4/5 

                     Baud = 

1200/2400/…/57600/115200 

                     Data = 7E/8N/8E 

 mbus             - Set MODBUS ID range and ETC 

MODBUS ID 

 modem            - Modem connection parameters 

 XP               - eXpertPower client parameters 

 time [hh:mm:ss]  - Time 

 date [dd/mm/yy]  - Date 

 log              - Prints network log 

 stat             - Prints network statistics 

 stat ip          - Prints current network IP 

addresses 

 stat xp          - Prints XP client status 

 service          - Service Menu 

 datasrv          - Data server configuration 

 run dump         - Starts dumping the log to 

console 

 run server       - Starts the TCP server 

 stop dump        - Stops dumping the log to 

console 

 stop server      - Shuts the TCP server down 

 reset            - Resets the device 

 rsttmr           - Reset timer period 

 quit             - Quit console 

 

 

You are prompted for the login name and password to login, as in the following 
example:   

Login Name: ******* 

Login password: ****** 

> 

 

If your login was successful, you are not prompted for the password again until 
you close your telnet session. Consult your local representative for the default 
ETC II login name and password.  

After receiving the Telnet prompt “>”, you may enter your commands. 

Closing a Telnet Session 

To close your Telnet session, close your telnet client application. 

Dial-Up Networking 
You can use Windows Dial-Up networking to access the ETC II via public 
telephone lines, either for connecting to the ETC II TCP server from PAS or 
your remote Internet application, or for connecting to the ETC II Telnet server 
from the Windows Telnet client.  

To use Windows Dial-Up Networking for dial-in connections, create a new 
Dial-Up connection for your ETC II: 

1. From the Start menu, select Settings -> Network and Dial-Up 
Connections -> Make New Connection. 

2. Select “Dial-up to the Internet” and click Next. 
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3. Select “I want to set my Internet connection manually” and click Next. 

 

4. Select “I connect through a phone line and a modem” and click Next. 

 

5. Select a modem you use to connect to the Internet and click Next. 
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6. Type the telephone number of the ETC II modem and click Next. 

 

7. Leave the user name and password boxes blank and click “Next”. In dial-
in mode, the ETC II does not require the name and password to login. 
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8. Type the connection name and click “Next”.  

 

9. Check “No” and click “Next”.  

 

Later, you can use the name of your Dial-up connection in Internet 
applications to dial to the ETC II. For all Dial-up Internet connections, use the 
IP address you have defined in your ETC II for the modem interface via the 
Dial-Up Networking Setup (see Configuring Dial-Up Connections in Chapter 
5). 

Using PAS Software 
Supplemental PAS software that came with your ETC II can be used for 
configuring the ETC II via the Internet.  

See the “PAS Getting Started Guide” supplied on the installation CD for 
information on how to install PAS on your PC. 

Configuration Database 

To communicate with the ETC II from PAS, create a site database for your 
device. All communication and configuration data for your device will be 
stored in this database. During configuration, store all setups to the site 
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database so that PAS recognizes device properties regardless of whether the 
ETC II is online or offline. 

To create a new database for your ETC II: 

1. Select Configuration from the Tools menu, and then click the Sites button 
on the right-hand side. 

 

2. From the “Look in” box, select the directory where the new database will 
be stored. By default, it is the “Sites” directory. Type a site name for your 
device in the “File name” box, click New, and then click OK.  

3. On the Instrument Setup tab, select “ETC II” in the “Model” box. 

4. Set the device address to 99 unless you have changed the ETC II default 
address in your device. 

5. If you wish to add any comments for your device, type them into the 
“Comment” box. 

Setting up Communications 

Communicating through the Ethernet 

To communicate through the Ethernet port: 

1. On the Instrument Setup tab, select Internet Site. 

2. Click on the Connection tab.  

3. Click on the “IP address” and type in the IP address that you defined in 
Network Setup in your ETC II. The factory set default IP address is 
192.168.0.203. 

4. In the “Protocol” box, select the communications protocol for the ETC II 
TCP port. The host port is set automatically as you select the protocol. 
Select “Modbus RTU” for Modbus/TCP, “DNP3” for DNP3/TCP, or 
“SATEC ASCII” for SATEC ASCII/TCP. 

5. In the “Wait for answer” box, adjust the time that PAS should wait for a 
connection before announcing an error and the number of re-tries that 
PAS should use to receive a response from the device if communications 
fail. 
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Communicating through a Dial-up Connection 

Configuring a Dial-up Connection 

To communicate through a Dial-up modem: 

1. On the Instrument Setup tab, select Internet Site. 

2. Click on the Connection tab.  

 

3. Click on the “IP address” and type in the IP address you defined in Dial-
Up Networking Setup in your ETC II. The default IP address preset at the 
factory is 192.168.10.203. 

4. In the “Protocol” box, select the communications protocol for the ETC II 
TCP port. The host port is set automatically as you select the protocol. 
Select “Modbus RTU” for Modbus/TCP, “DNP3” for DNP3/TCP, or 
“SATEC ASCII” for SATEC ASCII/TCP. 

5. In the “Wait for answer” box, adjust the time that PAS should wait for a 
connection before announcing an error and the number of re-tries that 
PAS should use to receive a response from the device if communications 
fail.  

6. In the “Connection” box, select the Dial-up connection you created for the 
ETC II. See Dial-Up Networking for information on how to create a Dial-
up connection in Windows. 
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7. Check the AutoDial box, if you wish PAS to automatically connect to your 
ETC II every time you access it from PAS; otherwise you must manually 
dial your connection. 

Manually Dialing your Connection 

To manually dial your connection: 

1. Select your connection name from the Start menu -> Settings -> Network 
and Dial-Up Connections. 

 

2. Click Dial. 

Setting Up the ETC II 

PAS allows you to prepare setup data for the ETC II offline without the need 
to have it connected to your PC.  

Select the ETC II site from the list box on the PAS toolbar, and then select the 
desired setup group from the Meter Setup menu. Click on the tab with the 
setup you want to create or modify, and then fill in the boxes with the desired 
configuration data.  Click the “Save as…” button to store your new data to the 
site database.  

To save your setup to another site database, select it from the file panel, and 
then click OK.  

To re-use setups from another site, copy them to your present site database. 
Click Open, select the desired site database, and then click OK. The opened 
setup is copied to your site database.  

You can also copy all setups from one site database into another site's 
database. Select a device site from the list box on the toolbar from which you 
want to reproduce setups, and then select “Copy to...” from the Meter Setup 
menu. Select the site database to which to copy setups, and click OK. 

Downloading Setup to the ETC II 

You can update each setup in your ETC II one at a time or download all setups 
together from the site database.  

To update a particular setup in your device, check the On-line button on the 
PAS toolbar, select a device site from the list box on the toolbar, and then 
select the desired setup group from the Meter Setup menu. Click on the tab 
of the setup you want to download to the device, and then click Send.  

To download all setups to your device at once, check the On-line button on 
the PAS toolbar, select the device site from the list box on the toolbar, and 
then select Download Setups from the Meter Setup menu. 
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Uploading Setup from the ETC II 

To upload the setup from the ETC II to the site database, check the On-line 
button on the PAS toolbar, select the device site from the list box on the 
toolbar, and then select Upload Setups from the Meter Setup menu. 

Authorization 

If communications with your ETC II is secured, you are prompted for the 
password when you send new setup data to the device.  

 

Enter the password and click OK. If your authorization was successful, you 
are not prompted for the password again until you close the dialog window.  
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Chapter 5   Setting Up the ETC II 
You can configure your ETC II via the Terminal program connected to the 
device through the COM3 service port, via the Telnet, or via PAS. See 
Connecting to the ETC II for information on establishing a connection with your 
device using different communication options. 

Changing the Password and Security 

Using HyperTerminal or Telnet 

To change your password or a security option: 

Type password and press Enter. The following prompt appears: 

> password 

New Password [0-99999999]: 

  

To change the password, type your new password (up to 8 digits) and press 
Enter, then repeat your new password when prompted and press Enter. To 
leave the password unchanged, just press Enter. 

New Password [0-99999999]: ******** 

Repeat Password [0-99999999]: ******** 

 

Type y to enable or n to disable password checking, and then press Enter. To 

leave the current setting unchanged, just press Enter. 

Comm/Network Protection Enabled [y/n]: N 

New: Y 

Using PAS 

To change the password, check the On-line button on the PAS 
toolbar, select Administration from the Monitor menu, and then 
select Change Password.  

 

To change the password: 

1. Type in a new 8-digit password. 

2. Repeat the password in the Confirm box. 

3. Check the “Enable network protection” box to enable 
password checking. 

4. Click Send. 

 

Changing Time and Date 

Using HyperTerminal or Telnet 

To view or change time or date in the ETC II, type time or date, and then 

press Enter. To change the time or date, type the new setting after the prompt 
and press Enter. To leave the time unchanged, just press Enter. 
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>time 

Time: 15:24:49 

New: 

 

or  
 

>date 

Date (dd/mm/yy): 27/04/03 

New: 

Using PAS 

Select the ETC II site from the list box on the PAS toolbar, check the On-line 
button, and then select RTC from the Monitor menu.  

Click Set to synchronize the ETC II clock with your PC’s clock.  

 

Configuring Local Time Settings 

Using PAS 

This setup allows you to specify your time zone and daylight 
savings time options in the ETC II.  

Select the ETC II site from the list box on the PAS toolbar, select 
General Setup from the Meter Setup menu, and then click on 
the Local Settings tab. 

The available setup options are listed in the following table: 

Parameter Options Default Description 

Time zone offset, 
min 

-720 to 720 min -300 
(Eastern 
Time) 

Local offset in minutes from UTC 
(Universal Coordinated or Greenwich 
Mean Time). It is used to produce a 
local time from the GPS IRIG-B time 
code. 

Daylight savings 
time 

Disabled 
Enabled 

Disabled When DST is disabled, the RTC 
operates in standard time only. When 
enabled, the device automatically 
updates the time at 2:00 AM at the 
pre-defined DST switch dates. 

DST start month 
DST start week 
DST start 
weekday 

Month-week-
weekday 
Week = 1st, 2nd, 3rd, 
4thor Last (last week 
of the month) 

First 
Sunday in 
April 

The date when Daylight Savings Time 
begins. The DST switch point is 
specified by the month, week of the 
month and weekday. By default, DST 
starts at 2:00 AM on the first Sunday 
in April of each year.  

DST end month 
DST end week 
DST end 
weekday 

Month-week-
weekday 
Week = 1st, 2nd, 3rd, 
4thor Last (last week 
of the month) 

Last 
Sunday in 
October 

The date when Daylight Savings Time 
ends. The DST switch point is 
specified by the month, week of the 
month and weekday. By default, DST 
ends at 2:00 AM on the last Sunday in 
October of each year.  
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The daylight savings time option is disabled in the ETC II by default. The 
default daylight savings time change points are pre-set for the U.S.A.  

When daylight savings time is enabled, the meter automatically adjusts the 
device clock at 02.00 AM when daylight savings time begins/ends. If the 
daylight savings time option is disabled, you must manually adjust the device 
clock for daylight savings time. 

Configuring Serial Ports 

Using HyperTerminal or Telnet 

To view the present serial port settings, type com and press Enter.  

>com 

COM3 19200 8N 

COM4 9600 8N 

COM5 9600 8N 

To change the serial port settings, type com followed by the port number, baud 

rate and data format, separated by a space, and press Enter, as in the 
following example:  

>com3 19200 8N 

COM3 19200 8N 

COM4 9600 8N 

COM5 9600 8N 

Using PAS 

To enter the setup dialog, select the ETC II site from the list box on the PAS 
toolbar, select Communications Setup from the Meter Setup menu, and then 
click on the Serial Ports Setup tab. Select the desired device port in the “Port” 
box.   
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To change the port settings, select desired port parameters, and then click 
Send. See Serial Port Connection in Chapter 3 for information on using serial 
ports and available options. 

Configuring the Network 

Using HyperTerminal or Telnet 

To view your present network settings, type stat ip and press Enter: 

>stat ip 

Ethernet Address Statistics (ENET) 

  Name:              D-Link DE-220 Ethernet 

driver 

  IP address:        192.168.0.213 

  Subnet mask:       255.255.255.0 

  Gateway:           192.168.0.1 

PPP Address Statistics (PNET) 

  Name:              Modem Driver 

  IP address:        192.168.10.203 

  Subnet mask:       255.255.255.0 

  Gateway:           192.168.10.204 

To change the network settings, type ip and press Enter. If you wish to 

change a parameter, type your new setting after the prompt and press Enter. 
To leave the setting unchanged, just press Enter.  

>ip 

Use DHCP (0/1 = no/yes): 0 

New: 

Network IP address: 192.168.0.203 

New: 

Network subnet mask: 255.255.255.0 

New: 

Network default gateway: 192.168.0.1 
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New: 

Refer to your network administrator for the available IP address and correct 
subnet mask and default gateway settings.  

If you enable DHCP (Dynamic Host Configuration Protocol), the ETC II obtains 
the network settings automatically from your network server when the ETC II 
restarts. You must know the actual IP address assigned to your ETC II in order 
to specify the device network address in PAS or another application software. 
Use the stat ip command to view the actual IP address assigned to your 
device. 

NOTES: 

1. If you use the modem interface for dial-out Internet connections, set the 
default gateway address to 0.0.0.0. See Dial-Out Connections in Chapter 
3 for more information on using dial-out networking.  

2. When you change a network parameter, the ETC II restarts the network 
to accept your new settings. If you configure your device through telnet, 
your current connection will be lost and you will be required to open a 
new session. 

To view or change the ETC II TCP server port setting, type port and press 

Enter.  

>port 

TCP service port: 502 

New: 

The TCP service port number defines the communication protocol for the ETC 
II gateway that is used for master-slave communications over the networks. 
See the table below for available port numbers. 

Using PAS 

To enter the Setup dialog, select the ETC II site from the list box on the PAS 
toolbar, select Communications Setup from the Meter Setup menu, and then 
click on the Network Setup tab.  

 

The following table lists available network options.  

Parameter Options Default 

Device IP Address  192.168.0.203 
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Parameter Options Default 

Network Subnet Mask  255.255.255.0 

Network Default Gateway  192.168.0.1 

TCP Service Port 502 = Modbus/TCP 
20000 = DNP3/TCP 
5002 = SATEC ASCII/TCP 

502 

 
NOTE: 

Starting with V21.5.4, the ETC II provides the permanent Modbus/TCP server 
on port 502. Selecting the TCP service port in the ETC II launches an 
additional server either on the DNP3/TCP port 20000, or on the SATEC 
ASCII/TCP port 5002, allowing simultaneous connections via the two ports. 

Configuring Dial-Up Connections 

Using HyperTerminal or Telnet 

To view or change the modem settings, type modem and press Enter. If you 

want to change a parameter, type your new setting after the prompt and press 
Enter. To leave the setting unchanged, just press Enter. Refer to the table 
below for the available connection options and their description. 

>modem 

Number of dial attempts: 0 

New: 

Connection timeout (sec): 180 

New: 

Delay between redials: 1 

New: 

Idle connection timeout (sec): 60 

New: 

Rings before answer: 8 

New: 

Modem init AT command: ATZ0&F 

New: 

#1 Phone number to dial: 

New: 

#1 Login name: 

New: 

#1 Login password: ****** 

New: 

Network IP address: 192.168.10.203 

New: 

Network subnet mask: 255.255.255.0 

New: 

Network default gateway: 192.168.10.1 

New: 

> 

NOTES: 

1. The factory-set modem initialization string should not be changed. 

2. The phone number is allowed to contain special characters that may be 
used to format the dial string and to control a dialing sequence. The 
following characters may be used within the dial string:  

,     Dial pause: the modem will pause for a specified 
time before   dialing the following digits. 
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W   Wait for dial tone: the modem will wait for a dial 
tone before dialing the digits following "W". 

 

@   Wait for silence: the modem will wait for at least 
5 seconds of silence before continuing with the 
next dial string parameter. 

( )    Ignored: may be used to format the dial string. 

-    Ignored: may be used to format the dial string. 

<space>  Ignored: may be used to format the dial string. 

Example: 9W02, 5411000  

Using PAS 

To enter the Setup dialog, select the ETC II site from the list box on the PAS 
toolbar, select Communications Setup from the Meter Setup menu, and then 
click on the Dial-Up Networking Setup tab.  

 

The following table lists available connection options. 

Parameter Options Default Description 

Dial-in Connection Options 

IP Address  192.168.10.203 The ETC II IP address on the modem 
PPP network. Use it in your Dial-Up 
networking applications for 
connections to the ETC II TCP 
server. 

Network Subnet 
Mask 

 255.255.255.0 The ETC II PPP network subnet mask 

Network Default 
Gateway 

 192.168.10.1 The ETC II PPP network default 
gateway 

Idle Time Before 
Hanging Up 

1-9999 sec 60 The modem disconnects a call if idle 
for more than the specified idle time. 

Rings before 
Answer 

1-99 8 The number of rings before the 
modem answers an incoming call 
from a remote modem. 
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Parameter Options Default Description 

Dial-out Connection Options 

Redial Attempts 0-1000,  

0 = dial forever 

0 The number of dial attempts to 
connect to a remote modem if a 
connection was unsuccessful. 

Time Between 
Redial Attempts 

0-9999 sec 1 A time delay between redials.  

Connection 
Timeout 

0-9999 sec 180 The modem cancels a call if not 
connected within the connection 
timeout time. 

Idle Time Before 
Hanging Up 

1-9999 sec 60 The modem disconnects a call if idle 
for more than the specified idle time. 

Phone Number   The telephone number of the ISP 
provider. 

Login Name   Login name for logging onto the 
Internet. 

Login Password   Login password for logging onto the 
Internet. 

 

Configuring Gateway Options 

Using HyperTerminal or Telnet 

To view or change the ETC II gateway settings, type mbus and press Enter. 

To change a parameter, type your new setting after the prompt and press 
Enter. To leave the setting unchanged, just press Enter.  

>mbus 

ETC MODBUS ID: 99 

New: 

Start address: 1 

New: 

End address: 215 

New: 

Sharing control Enabled [y/n]: N 

New [y/n]: 

> 

See Routing Messages over Slave Networks in Chapter 3 for information on 
defining the gateway address range and the ETC II service address. See 
Shared Device Access in Chapter 3 for information on shared device 
accesses. 

Using PAS 

To enter the Setup dialog, select the ETC II site from the list box on the PAS 
toolbar, and then select ETC II Setup from the Meter Setup menu.  
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The following table lists available options.  

Label Options Default Description 

ETC II Device Address 1-247 99 The ETC II network ID 

Device Address Range 
Start 

1-247 1 The start slave device address 
on the gateway 

Device Address Range 
End 

1-247 215 The end slave device address 
on the gateway 

Routing Table Disabled, 
Enabled 

Disabled Enables using the device 
routing table 

Shared Device Access Disabled, 
Enabled 

Enabled Enables multiple accesses to 
slave devices from a number 
of clients  
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Configuring Device Routing Table 

Using PAS 

To enter the Setup dialog, select the ETC II site from the list box on the PAS 
toolbar, select ETC II Setup from the Meter Setup menu, and then click on the 
Device Routing Table tab.  

 

The routing table allows you to specify a routing path and the shared device 
access rules for every slave device connected to the ETC II. Note that the 
Ethernet devices can only be accessed via the routing table. 

See Routing Messages over Slave Networks in Chapter 3 for information on 
using the routing table in the ETC II. See Shared Device Access in Chapter 3 
for information on shared device accesses. 

The following table lists available routing options.  

Label Options Default Description 

Gateway Port Ethernet, 

COM4, COM5 

COM4 The ETC II port to 
which the device-
addressed messages 
will be routed 

Device IP 
Address 

 192.168.0.203 The Ethernet device IP 
address 

Shared Device 
Access Rules 

None – no access limitations, 
#1 – PM296 family (PM296, 
PM171, PM172) 
#2 – SA300 family (SA300, 
PM174, PM175, EM610, 
BFM136) 

None Specifies the device-
sharing policy for 
simultaneous client 
accesses 

When selecting the device-sharing policy, select the appropriate rules 
corresponding to the device family. In this case, the critical device registers 
will be protected from simultaneous accesses. 

NOTE:  

Enable the routing table via the ETC II Gateway Options Setup to make it 
effective in your ETC II (see Configuring Gateway Options above).  
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Configuring eXpertPower Client 

Using HyperTerminal or Telnet 

To view or change the eXpertPowerTM settings, type xp and press Enter. To 

change a parameter, type your new setting after the prompt and press Enter. 
To leave the setting unchanged, just press Enter. 

>xp 

XpertPower IP address: 194.90.237.19 

New: 

XpertPower TCP service port: 5001 

New: 

XpertPower client Enabled [y/n]: N 

New [y/n]: 

Connection period (min): 10 

New: 

Time to next session: 0 

See the table below for available options. Refer to your eXpertPower service 
provider for the correct eXpertPower settings. See eXpertPowerTM Client in 
Chapter 3 for more information on the eXpertPowerTM service. 

NOTES 

1. If you do not use the eXpertPowerTM service, do not enable the 
eXpertPower client in your ETC II. 

2. Do not change the connection period setting. The eXpertPower 
server updates it automatically.  

Using PAS 

To enter the Setup dialog, select the ETC II site from the list box on the PAS 
toolbar, select Communication Setup from the Meter Setup menu, and then 
click on the ExpertPower Client Setup tab.  
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The following table lists available options.  

Parameter Options Default Description 

XPW Server IP Address  207.232.60.18 The IP address of the 
eXpertPower server 

XPW Server Port 0-65535 5001 The TCP service port of the 
eXpertPower server 

XPW Client Enabled NO, YES NO Enables operations of the 
eXpertPower client 

Time to Next Session, min 1-99999 
 

 The time remaining to the 
next connection session  

 

Configuring Data Server 

Using HyperTerminal or Telnet 

See Data Server in Chapter 3 for information on Data server operations. 

To view or change the Data server settings, type datasrv and press Enter.  

>datasrv 

You will be prompted for the password. The factory-set password is 0 unless 
you have changed it in your ETC II.   

Enter password:* 

Data Server Configuration Commands 

------------------------------------ 

h      - Display this text 

p      - Server parameters 

s [N]  - Set address range * 

i [N]  - Display address range settings * 

q      - Quit menu 

         *(N - address range number) 

Data server> 

Data Server Options 

To view the Data server options, type i and press Enter.  

Data server>i 

Data Server Configuration 

------------------------------------  

Data server        disabled 

Continuous polling disabled 

Polling interval 1 min 

Logging interval 1 (x1min) 

To setup or change the Data server options, type p and press Enter. To 

change an option, type your new setting after the prompt and press Enter. To 
leave the setting unchanged, just press Enter. Refer to the table below for the 
available options and their explanation.  

Data server>p 

Data server: disabled 

New [y/n]: 

Continuous polling: disabled 

New [y/n]: 

Polling interval: 1 min 

New: 



Chapter 5  Setting Up the ETC II Configuring Data Server 
 

 

44 ETC II Network Communicator 
 

Logging interval: 1 (in polling interval units) 

New: 

Data Server Exchanges 

See Data Server in Chapter 3 for more information on using Data server 
exchanges. 

To inspect the present configuration (to leave the settings unchanged, just 
press Enter) or configure the Data server exchanges:  

1. Type s and press Enter. The following prompt appears: 

 Data server>s 

Data Exchange No:  

2. Type the data exchange number, and then specify the device address, 
the start device register and the number of registers in the real-time data 
exchange. Note that the real-time, status event and write data exchanges 
with the same exchange number are internally linked in the ETC II to the 
same device address. 

Device ID: 1 

 New: 

Start device register address: 256 

 New: 

 Number of registers: 1 

 New: 

3. Enable real-time polling for the exchange if you want to start exchange 
operations: 

 Polling: enabled 

 New [y/n]: 

4. Enable updating the real-time clock in the device if you wish to 
periodically synchronize its clock with the ETC II clock: 

RTC update: disabled 

New [y/n]: 

5. Specify the start device register and the number of registers in the write 
data exchange: 

Write block start register address: 200 

New: 

Number of registers: 10 

New: 

6. Enable polling for the write data exchange if you want to start exchange 
operations: 

Polling: disabled 

New [y/n]: 

7. Specify the device status register and a register mask for a status event 
exchange: 

Status register address: 400 

New: 

Status register mask: 0xC000(HEX) 

New: 

8. Enable polling for the status event exchange if you want to start exchange 
operations: 

Status polling: disabled 

New [y/n]: 
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9. Enable the auto-reset option, if you wish the register to be automatically 
cleared after it has been read: 

Status register auto-reset: disabled 

New [y/n]: 

10. Enable using Modbus Request 1 if you wish the register to be read as 
coils: 

Register type: holding 

New [coil/holding]: 

Data server< 

11. Type q to quit the Data server menu. 

Using PAS 

Data Server Options 

To enter the Setup dialog, select the ETC II site from the list box on the PAS 
toolbar, and then select ETC II Setup from the Meter Setup menu.  

 

The following table lists available Data server options.  

Parameter Options Default Description 

Polling Interval 1-1000 min 1 min Specifies the interval for 
periodic polling connected 
devices 

Logging Interval, polls 0-1000, 

0=logging 
disabled 

1 A non-zero interval enables 
recording the acquired data 
to the log file at predefined 
intervals 

Data Server Operations Disabled, 
Enabled 

Disabled Enables Data server 
operations 

Continuous Polling Disabled, 
Enabled 

Disabled If enabled, the Data server 
polls devices continuously 
without taking the polling 
interval into account. 

See Data Server in Chapter 3 for more information on using the Data server.  

Real-Time Data Exchanges 

To enter the Setup dialog, select the ETC II site from the list box on the PAS 
toolbar, select ETC II Setup from the Meter Setup menu, and then click on the 
Real-Time Data Exchanges tab.  
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See Data Server in Chapter 3 for more information on using real-time data 
exchanges. Refer to the ETC II Modbus Guide for information on how to 
access the acquired real-time and logged data via communications. 

The following table lists available options.  

Parameter Options Default Description 

Device Address 1-247 1 Defines the device to which 
the exchange is linked 

Device Start Register 0-65535 0 Defines the start device 
register for real-time polling 

Block Size 1-114 0 Defines the number of 
contiguous registers in the 
exchange 

Polling Enabled Disabled, 
Enabled 

Disabled Enables polling the device 

RTC Sync Enabled Disabled, 
Enabled 

Disabled If enabled, the Data server 
synchronizes the device 
clock with the ETC II clock 

To configure a real-time data exchange: 

1. Define the device address for a data exchange. Note that the real-time, 
status event and write data exchanges with the same exchange number 
are internally linked in the ETC II to the same device address. 

2. Specify the start register address of the area in the device Modbus map 
you wish to be polled via the exchange. 

3. Type the number of registers in the exchange. Up to 114 registers can be 
specified for a single exchange. As you type the register address range, 
PAS immediately shows you the start register address in the ETC II 
exchange area for accessing the acquired data from the remote 
applications. 

4. Check the “Polling Enabled” box to activate the exchange. 

Status Event Exchanges 

To enter the Setup dialog, select the ETC II site from the list box on the PAS 
toolbar, select ETC II Setup from the Meter Setup menu, and then click on the 
Status Event Exchanges tab.  
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See Data Server in Chapter 3 for more information on using status event 
exchanges. Refer to the ETC II Modbus Guide for information on how to 
access the event log data via communications.  

The following table lists available options.  

Parameter Options Default Description 

Device address 1-247 1 Defines the device to which 
the exchange is linked 

Register Address 0-65535 0 Defines the device status 
event register address for 
polling 

Event Mask 0-0xFFFF 0 Defines the bit mask for bits 
which status must be 
checked for events 

Polling Enabled Disabled, 
Enabled 

Disabled Enables polling the status 
register  

Auto Reset Disabled, 
Enabled 

Disabled If enabled, the Data server 
clears the device register 
after it has been read 

To configure a status event exchange:  

1. Define the device address for a status event exchange. Note that the real-
time, status event and write data exchanges with the same exchange 
number are internally linked in the ETC II to the same device address. 

2. Specify the device status register address you wish to be polled via the 
exchange. 

3. Specify the event mask for bits you wish to be checked for events. 

4. Check the “Polling Enabled” box to activate the exchange. 

5. Check the “Auto Reset” box if you want the status register to be cleared 
after polling. 

Write Data Exchanges 

To enter the Setup dialog, select the ETC II site from the list box on the PAS 
toolbar, select ETC II Setup from the Meter Setup menu, and then click on the 
Write Data Exchanges tab.  
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See Data Server in Chapter 3 for more information on using data exchanges. 
Refer to the ETC II Modbus Guide for information on how to put data into a 
write exchange and to trigger it via communications.  

The following table lists available options.  

Parameter Options Default Description 

Device address 1-247 1 Define the device to which 
the exchange is linked 

Device Start Register 0-65535 0 Defines the start device 
register for a write 

Block Size 1-12 0 Defines the number of 
contiguous registers in the 
write exchange 

Write Enabled Disabled, 
Enabled 

Disabled Enables writing data to the 
device upon a trigger 

To configure a write data exchange:  

1. Define the device address for a write data exchange. Note that the real-
time, status event and write data exchanges with the same exchange 
number are internally linked in the ETC II to the same device address. 

2. Specify the start register address of the area in the device Modbus map 
you wish to be written via the exchange. 

3. Type the number of contiguous registers in the exchange. 

4. Check the “Write Enabled” box to activate the exchange.
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Chapter 6   Upgrading Device Firmware 
This chapter describes the procedure of upgrading firmware in the ETC II 
through the COM3 RS-232 service port using Windows HyperTerminal.  

When you put your device into program mode, its COM3 port operates at 
19200 baud by default. Downloading firmware at a slow baud rate may be very 
time-consuming. It is recommended to use the maximum available speed of 
115200 baud for downloading firmware. Prepare a HyperTerminal session file 
for communicating with the ETC II at 115200 baud before you start upgrading 
firmware in your device. See Using HyperTerminal in Chapter 4 for information 
on preparing a session file for HyperTerminal. 

Opening a Terminal Session 

1. Connect your PC to the ETC II COM3 RS-232 port using the standard 
RS-232 DTE-DTE (null-modem) cable that came with your ETC II.  

2. Run a HyperTerminal session. See Using HyperTerminal in Chapter 4 for 
information on launching and configuring HyperTerminal. 

Put the PROG-RUN key on the front of the ETC II in the PROG position. 

Downloading Firmware to the Device 

1. Print loader and press Enter. The following text appears: 

>loader 

Are you sure you want to run Boot Loader now? 

[y/n]: y 

2. Enter y and press Enter. The following text appears: 

The ETC II will stop operations! 

Run anyway? [y/n]: y 

3. Enter y and press Enter. The Flash Loader is launched and prints a list 

of the available commands as follows: 

ETC II Flash Loader Ver.1.2.1 

Copyright (C) 2003, SATEC Ltd. 

Firmware information 

-------------------- 

Bootloader: Version 1.2.1, size 20512 bytes, 

checksum 0x227E 

Main program: Version 10.2.8, size 336260bytes, 

checksum 0x38A3 

Flash Loader commands 

--------------------- 

 h - Display this text 

 i - Display boot information 

 b - Display/change baud rate 

 p - Download a program into Flash 

 v - Verify a program 

 n - NIC Configurator 

 q - Quit Flash Loader and restart a program 

 > 

4. Print b and press Enter.  

>b 

Baud Rate: 19200 
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New: 115200 

5. Print 115200 and press Enter. Now the Flash Loader communicates at 

115200 baud. 

6. To accommodate HyperTerminal to the new baud rate, select Open from 
the File menu, click Yes in response to the HyperTerminal question, and 
then double-click on your “115200” session file.  

7. Print p and press Enter. The following text appears: 

p 

 

Programming Flash 

----------------- 

Send HEX-32 file as a text file. 

NB: Use standard XON/XOFF flow control. 

NB: Ensure that LF is not stripped at the end 

of lines. 

To abort downloading, press Esc. 

 

0 characters received... 

 

8. From the Transfer menu, select Send Text File, and then select “All files 
(*.*)” in the “File of type” box. On the file pane, point to your new firmware 
image HEX file and click Open. HyperTerminal starts the file transfer. 

When downloading is complete, the following message 
appears: 

Downloading complete. 924836 characters 

received. 

336260 bytes written into Flash. 

> 

 

If downloading fails, repeat steps 7 and 8 again. 
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Chapter 7   Device Maintenance 
This chapter describes the battery replacement procedure. See Figures 7-1 to 
7-4 for replacement instructions.  

 Observe the battery polarity. The battery polarity appears on the 
inner part of the battery cover.  

 

 

Figure 7-1 Battery Housing Location of the Panel 

 

Figure 7-2 Battery Housing Cover Removal 
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Figure 7-3 Battery Removal 

 

Figure 7-4 Insertion of New Battery  
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Appendix  Technical Specifications 

Environmental Conditions 

Operating temperature: -20°C to 60°C (-4°F to 140°F) 

Storage temperature: -40°C to 85°C (-13°F to 176°F) 

Humidity: 0 to 95% non-condensing 

Construction 

Dimensions: see Figure 2-1   

Weight: 1.23kg (2.7 lb.) 

Materials 

Enclosure: Aluminum 

Terminals: PBT (UL94-V0) 

Connectors: plug-in type, Polyamide PA6.6 (UL94-V0) 

Packaging case: Carton and Stratocell® (Polyethylene Foam) 
brackets  

Power Supply 

120/230 VAC, 50/60 Hz: Rated input: 85-265 VAC  

120/220 VDC Option: Rated input 88-290VDC,  

Burden: 10W 

Isolation: 3200 VRMS 

12 VDC Option: Rated input 9.6-19 VDC 

24 VDC Option: Rated input 19-37 VDC 

48 VDC Option: Rated input 37- 72 VDC 

Burden: 10W 

Isolation (except 12VDC): 1350 VRMS 

Wire size: up to 12 AWG (up to 2.5 mm2) 

Communication Ports 

COM1 Ethernet Port 

Transformer-isolated 10/100BaseT Ethernet port. 

Connector type: RJ45 modular. 

Supported protocols: Modbus/TCP (port 502), SATEC 
ASCII/TCP (port 5001), and DNP3/TCP (port 20000). 

Number of simultaneous connections: 5. 

COM2 CELLULAR Modem (future) 

2G/3G Cellular Data Network 

Connector type: SMA 

COM3 Serial EIA RS-232 optically isolated port 

Isolation: 2,000 V RMS 

Connector type: DB9 female 

Baud rate: up to 115.2 kbps 

Supported protocols: Modbus RTU, Modbus ASCII and DNP3 

COM4, COM5 RS-422/RS-485 optically isolated ports 

Isolation: 2,000 V RMS 

Connector type: removable, 5 pins 
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Wire size: up to 12 AWG (up to 2.5 mm2) 

Terminals pitch: 5 mm 

Baud rate: up to 115.2 kbps 

Supported protocols: Modbus RTU, SATEC ASCII and DNP3 

Real-time Clock 

Accuracy: typical error 15 seconds per month @ 25C 

Log Memory 

Onboard memory with battery backup: 4 Mbytes. 

 

 

  

 


